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Hi, Everyone, we’re going to take a look at color models in digital environments.
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1. COLOR WHEELS
Primary, Secondary, Tertiary, Complementary, Warm/Cool
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First, you’ve probably all heard of “primary colors.” These are colors that can create 
all other colors when you are dealing with pigment (paints, inks, dyes, etc.).
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The secondary color wheel looks like this, with colors in between the primary colors. 
For example, between red and yellow is orange, because these two colors mixed 
together create orange. You’ve probably done this with water colors or other paints 
before.  
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The tertiary color wheel adds another “in-between” color to each space. For 
example, between red and orange is now the color “red-orange.” 
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Analogous Colors
A group of three colors next to each other on the color wheel.
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Summary
Primary, Secondary, Tertiary

Just to review . . . 
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Shades, Tints, Tones
Hue & Saturation

• Hue: A color in its pure form (from the color wheel)

• Shade: A color is shaded when black is added

• Tint: A color is tinted when white is added

• Tone: Color tones result when gray is added

• Saturation: Refers to the intensity of a color 
(shade a color with black to lower intensity or remove saturation by turning it 
black and white)
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2. CHOOSING COLORS
Trends, Codes, & COMMON METHODS
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Color Schemes are Based on Trends

in the 1980’s, this would have been an appalling color combination.
However, it was all the rage in the 2000’s.

While the color wheel helps to identify types of color schemes,
desirable color combinations are purely based on trends. 

For example, in the 1980’s, this would have been an appalling color combination. 

However, it was all the rage in the 2000’s.

11



Western Color Codes

Colors carry meaning
that is culturally relative.

The meanings colors communicate are not cultural universal—in other words, 
meaning varies from culture to culture. For example, in the U.S., white is equated 
with purity and is worn by the bride in weddings; black is equated with evil and death 
and is worn at funerals. Traditional Chinese culture associates black with water and 
the heavens (the night sky is black); it was believed the Heavenly Emperor resided in 
the North Star. In the West, the heavens are associated with daytime skies and white, 
fluffy clouds.

A culture’s values become coded in colors (among its other signifiers). In the West, 
“black” and “white,” connoting evil and good, also polarize perception of skin colors 
and notions of “race.” In traditional Chinese art, the standard colors are based on the 
five elements of traditional Chinese physics: black (signifying water), red (signifying 
fire), qing (青) (a mix of green and blue signifying wood), white (signifying metal), and 
yellow (signifying Earth).  Red symbolizes happiness and good fortune (associated 
with fire) and is worn by brides. In the West, red is associated with fire, but it 
symbolizes anger, passion, and hunger.
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Source: https://www.artworkabode.com/blog/the-science-of-colors-in-design/
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Monochromatic
A monochromatic color scheme uses one color.

A monochromatic color scheme uses one color with different tints and shades.
One benefit of using one color is the overwhelming power of the meaning that the 
color evokes.
However, a single color may not have the same attention-grabbing power an image 
with more colors.
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Complementary Colors

Complementary Colors: Have you ever learned about “complementary colors?” 

• Complementary colors lie opposite from one another on the color wheel. For 
example, red and green are complementary colors—opposites. 

• Complementary colors appear particularly vibrant and engaging when they are 
featured together. 

When you are thinking about color schemes, consider a common technique: using a 
combination of two complementary colors as the foundation (for example, red-violet 
and yellow-green). 

Then, you might add secondary or tertiary colors (e.g., accents of bright yellow and 
green). 

There are many other color strategies to consider. For more information about 
combining colors, see www.colorschemedesigner.com and 
https://color.adobe.com/create/color-wheel. 
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A composition with 
complementary colors 
provides vivid contrast.
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Warm and Cool Colors: 

• Warm colors give us a feeling of warmth: red, orange, yellow, for example. 

• Cool colors give us the feeling of coolness: green, blue, violet. 

• Most compositions need to include both warm and cool colors to stimulate 
interest. 

17



While these are not “complementary colors,” 
the warm and cool contrast simulates interest.
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Triad
Three colors compose a 
“triad” and can be chosen 
many different ways.

Here the dominant colors 
are blue, red, yellow 
(primary colors).

A monochromatic color scheme uses one color.
One benefit of using one color is the overwhelming power of the meaning that the 
color evokes.
However, a single color may not have the same attention-grabbing power is an image 
with more colors.
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Common Methods to Create

Here are common ways to create a “color scheme,” though there is no right or wrong 
way, since popular color schemes are largely based on trends.
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Examples

Analogous      Complementary       Triad

Credit: https://openlab.citytech.cuny.edu/mpaularenniscom-
grdesprin1/2018/12/02/color-your-selfie-3-develop/
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3. COLOR MODES
Creating Web & Print Colors
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CMYK
Cyanne, Magenta, Yellow, Black
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• Cyan, Magenta, Yellow, Key (Black)
• CMYK can create 

photographic color
on a printing press
or desktop printer.

• The process at the 
printer’s is called
“four color process printing.”

• CMYK cannot create neons or metallics.

CMYK Color Model
Four-color Process Printing

Now let’s move to the digital world, where color works a bit differently but by similar 
principles. 

CMYK stands for: cyan, magenta, yellow, and key (black). Notice that these colors 
resemble primary colors (red, yellow, blue), and you can think of these as the primary 
colors we use for printing. You can combine CMYK to create a wide range of colors. 
You can even create full color photographs with CMYK. The process is called “four-
color process printing.” Three of these colors (cyan, magenta, and yellow) can create 
most of the colors we commonly need. If we mix those three colors together, what 
color do you think they make? A muddy black, not a pure black—so, we need to add 
a pure black to the mix.
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CMYK Printing
Four-color Process Printing

A printer creates a full color photograph by laying down the four colors of ink (see 
above) in that process we called “four-color process printing.”
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Here is another example. This time, you can also see the “detail view” that shows a 
close-up of how the dots are laid down. When we pull back at a distance, the dots 
blur together and look like photographic realism. 
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Photoshop

When you open a new Adobe document (such as Photoshop), you have the option of 
selecting a color mode, such as CMYK, for print.
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SPOT COLOR
Pantone Colors
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Spot Color:
Pantone Books

• Specific colors selected from a library of colors (e.g., Pantone book).
• Can include metallic, neon, etc. (which can’t be created in CMYK)
• Can also include coated or uncoated.

Spot colors represent an entirely different system of printing. Let’s say you want a 
neon ink or a metallic ink. 
Those colors cannot be created with CMYK. Instead, you have to go to a color book 
and pick out an exact color to add on the printing press. 

PANTONE NUMBERS
But you can’t just tell the printer—”I want gold metallic.” There are all different 
shades of gold. So, you need to refer to a color book with a code that corresponds to 
the printer’s ink stock. 
The most common color book and spot colors printers have are called “Pantone.” So, 
you would choose a metallic Pantone spot color to add to your printing. 

COATED OR UNCOATED
You can also choose “coated” or “uncoated” versions of Pantone colors. 
Coated colors have a gloss and are good for using on glossy paper. Uncoated colors 
are matte.
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Spot Color: Saving Money
Spot color can save money if you have fewer than four colors to print.

But spot color is more typically used in a completely different situation. 
For print jobs that only need one, two, or three colors, why pay for four colors 
(CMYK)? Spot color is less expensive. 

Let’s say I am creating a newsletter with two colors: black and red, as we see above. I 
don’t need CMYK. I just need black and red. 
That’s less expensive and often more accurate, as well, because CMYK can’t always 
exactly match every color you might want, like that particular shade of seafoam green 
you love.

Notice the newsletter above also has gray. That is not a third color—it’s just black 
with low opacity. 
You can use your colors at various opacities without adding colors. 
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3-color Spot

Here’s an example of a logo that only has three colors: black, light blue, and orange. 
The colors are also used at varying opacities so that they create lighter and darker 
versions of the same colors. 
This is called a “3-color spot” job. You would select three spot colors from the 
Pantone book because there is no reason to pay for four colors (CMYK). 
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Pantone Books

Many designers have physical Pantone books at their sides to leaf through and see 
how the colors will appear on paper (because the computer screen can be deceiving). 
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Adobe Photoshop
1) Open Swatches Panel (Window > Swatches). 2) Click menu (upper right) and select Pantone.  

You can select Pantone colors to use in Adobe programs. 

In Photoshop, open the Swatches Panel (Window > Swatches) and click the menu in 
the upper right corner. Select the Pantone library you want.

33



Adobe Illustrator:
Windows > Swatch Libraries > Color Books > Pantone Uncoated (or Coated). 

In Illustrator:

1) Go to Windows > Swatch Libraries > Color Books > Pantone (e.g., Coated or 
Uncoated)

2) Select a color or type in the number of the color you’ve been given. It will be 
added to your swatches.

Tutorial Video:
https://helpx.adobe.com/illustrator/how-to/color-books.html?set=illustrator--
fundamentals--apply-color
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RGB
Red / Green / Blue
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CMYK vs. RGB

We have looked at color models used in print jobs. Now what about colors we see on 
television and computer screens? 
Those colors are not created with pigment—they are created with a palette of light. 
Light has completely different physical properties than pigments do. 

The three colors used to create all colors in lights are red, green, blue (RGB). 
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RGB Color Model

• Red, Green, Blue
• Used with light

(TV and computer 
screens).

To demonstrate how different this color model is from CMYK, what color do you think 
is created if you combine all three of these colors? 
It’s not black—not even a muddy black. It’s white. Weird, right? 
It’s just a different color model than you are probably used to. 
If you have ever worked with stage lights, you know that you can create a spot light 
by pointing these three colored lights together in one spot. 
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Photoshop

Just as you can select CMYK in Photoshop and other Adobe programs when creating a 
new file, so can you choose RGB.
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Photoshop

• It’s also possible to switch back and forth after a file has been created (Image > 
Mode). However . . .

• Keep in mind that RGB is a more vibrant color palette than CMYK, 
EXAMPLE: When light creates neon green, it’s super bright. When you shift to 
CMYK, that green is going to look more dull.

• Once you switch to CMYK, you cannot get back the vibrancy of the RGB colors. 
Therefore, many designers start in RGB (the brighter palette) when they’re using a 
design for both screen and print.
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HEXADECIMAL COLORS
(Web Safe)
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Hexadecimal Colors for Web

Now, let’s say you want the background color of a web page to be red. Instead of 
saying “red” (because there are lots of shades of red), you will need an HTML code to 
indicate the color. For example, this red is FF3333. This is called a “hexadecimal code” 
because it has six characters. The six characters indicate how much red, green, and 
blue is needed to create the color. 
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Web Colors: Hexadecimal Colors
• Used in web coding to indicate color.

To find a web color and its corresponding code, open your color picker in Illustrator or 
Photoshop and select the checkbox in the lower left indicating “Only Web Colors.” 
Then, select a color by clicking on it. The hexadecimal color will appear in the field 
denoted with a hashtag.

Now let’s say a client hires you to create a logo and tells you what their company 
colors are, including the hexadecimal codes. You can open the color picker and input 
the code in the # field (then press “Enter” or “Return”). The color will be selected and 
you can use it to create graphics in the program. 
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4. COLOR SCHEME APPS
How to Use Them
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Adobe’s Color Scheme App
• Adobe Color CC | (https://color.adobe.com)

Adobe’s color scheme app has 4 options: 
1) “Create” helps you to create color schemes based on a color principle you choose 
(e.g.,complementary colors—see example)
2) “Explore” searches for the most common images on the Internet that fit the colors 
you chose, so you have examples.
3) “Trends” demonstrates current color trends for various industries (fashion, graphic 
design, architecture, food, travel, etc.)
4) “My Themes” allows you to save your own themes to your library, share them, and 
download them for use in Adobe programs.
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Adobe Color CC | (https://color.adobe.com) 

Adobe’s Color Scheme App

Here
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How to create, save, download, and use your color scheme.

CHOOSE “My Themes” & LOG IN
CHOOSE “CREATE” TO CREATE/SAVE YOUR SCHEME

CHOOSE “MY THEMES” TO VIEW & DOWNLOAD 
YOUR THEME FROM YOUR LIBRARY

OPEN ADOBE PROGRAM, CHOOSE FILE > OPEN
BROWSE TO YOUR COLOR FILE & SELECT IT. 
NOW IT APPEARS IN SWATCHES TO USE

Adobe Color CC | (https://color.adobe.com) 

STEP 1: CREATE & SAVE YOUR COLOR SCHEME
1. Go to the Adobe Color CC app at https://color.adobe.com. 
2. Click on “My Themes” and log in.
3. Click on “Create” and select a “Color Harmony Rule” or select “Custom” 
4. Move the nodes on the color wheel until you get a color scheme you like, and 

click “Save.”

STEP 2: VIEW YOUR THEME IN YOUR LIBRARY & DOWNLOAD IT
When you click on “My Themes” again, you will see your new color scheme has been 
saved in your library.
Click on the color scheme to see it open up fully. You will now see many options, such 
as download, copy, edit, delete, etc.
Notice one option is to copy the color code of a color you choose (which can then be 
pasted into an Adobe program color palette.
Another option is “Download.” Download your theme to the desktop or a folder.

STEP 2: IMPORT YOUR THEME INTO ADOBE SOFTWARE TO USE IN SWATCHES
1. Open an Adobe program and go to File > Open. Browse to the color file you 

downloaded and select it.
2. Your color scheme will now appear in Swatches.
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Finding Color Codes in the Color Picker

When you select one of your color swatches and open it in the color picker, all 
numerical codes you will need will appear, including:

• RGB

• CMYK

• Hexadecimal

• Pantone Library
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Other Color Scheme Apps
Paletton Color Scheme Designer (www.colorschemedesigner.com)

The Paletton.com color scheme designer works on the same principles as Adobe’s but 
does not integrate with Adobe software.

48



5. WHAT YOUR CLIENT NEEDS
Providing Color Codes in Campaign Books and Client Presentations
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Color Charts

An ad agency will typically provide designers with a color palette for logos and other 
artwork. 
Here is a real color chart from ChappelRoberts for a client of theirs called Feeding 
Tampa Bay. 
The client is a nonprofit organization supplying food to all the distribution points on 
Tampa Bay, and these emblems represent various programs they offer. 

Notice that the color chart includes: 
- the Pantone colors, in case these need to be created with spot color
- CMYK numbers, in case you’re creating a four-color process printing job
- RGB colors, for screen
- web colors (hexademinal codes) for websites

Also note that you won’t get an exact match across color modes, but they’re close.
Guessing how to match colors across color modes can result in radically different 
colors.
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Optional Notes

© 1997-2023 Dick Patterson
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About “Ugly” Colors

We’ve already established that trends determine which colors are considered to be 
attractive in combination. 
There’s no such thing as an objectively “ugly” color scheme. 
But given current trends, at least, the colors above seem randomly placed.
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More Attractive Sequence

In contrast, this composition uses colors strategically.
1) Vertically, the colors start with black/white, then move to a warm color sequence 
and a cool color sequence.
2) Horizontally, colors that appear beside one another are complementary on the 
color wheel (purple/yellow, blue/orange, green/red). 

Nothing should be placed on a page randomy.
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